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はじめに  
D-Caseエディタは eclipseのプラグインとして実装されています。これは、eclipseの機能をプラグインの

追加によって拡張し、D-Case ダイアグラムの作成 /編集機能を実現していることを意味します。 

そのため、基本的な操作方法の多くは eclipse が提供している操作そのものです。エディタを円滑に利
用するに当たっては、eclipse の基本操作を理解していることが必要となります。 

本書では、D-Case エディタとして拡張した機能に関連する操作方法について記述しています。eclipse
の基本的な機能や操作方法については eclipse 関連の書籍などを参照してください。 

ダイアグラムファイルを管理する仕組みも eclipse のファイル管理の仕組みを利用しています。ワークス
ペース、プロジェクト、フォルダの概念は、eclipse で扱うそれらと同等です。 
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1. 設定  
1 . 1 .  Preferences 設定  
 

Eclipse の“Window” >“Preferences” >“D-Case Diagram”で各種設定を行う。 

 

Parameters 
 

Ｄ-Ｃａｓｅダイアグラムで使用するパラメータを定義する。 

利用可能なパラメータと属性  

型  属性  

string min：文字数の下限 
max：文字数の上限 

raw min：文字数の下限 
max：文字数の上限 

int min：下限 
max：上限 

double min：下限 

max：上限 

digit:小数点以下の桁数 

inc:増減幅 

enum items:項目一覧 

表 1 パラメータ型 

 

以下の文字はパラメータ名には使用禁止とする。 

, ; { } ＝ 

 

以下の語句は予約語のためパラメータ名として使用できない。 

id 

Requirements  

n  

以下の文字は enumuration の item 名には使用禁止とする。 

, ; { } 

 

設定したパラメータ 

パラメータ定義はＸＭＬファイルにより、Import/Export 可能とする。 

import 時、すでに定義されているパラメータは削除しない。パラメータ名が既存のものと同一であれば上
書きする。 

パラメータ名が予約語であれば、インポートしない。
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Bookmarks 
Ｄ-Ｃａｓｅダイアグラムで使用する bookmark 名とＵＲＬを登録する。 

 

Converters 
Ｄ-Ｃａｓｅダイアグラムで使用する coverter名と XSL ファイルへのパスを登録する。登録可能な converter
は XSL ファイル(*.xsl,*.xslt)のみとする。 
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2 .  ダイアグラムの作成と保存 
 

2 . 1 .  ダイアグラム新規作成  

ダイアグラムを新規作成 
D-Case ダイアグラムを新規に作成するためには、以下の手順でプロジェクトフォルダ内に新規ダイアグラ
ムを生成する。 

ダイアグラムの新規作成フロー  

No .  操作  アクション 詳細 

1 eclipse の File メニューから

New→Other...を選択する。 
New ウイザードが表示される eclipse の基本操作 

ウイザードを起動する。 

2 D-CaseEditor カテゴリの

D-Case Diagram を選択し、

Next ボタンを押下する。 

D-Case Diagram が選択され画面

が遷移する。 

eclipse の基本操作 

ウイザードによる情報の入力を行なう。 

新規作成の対象として D-CaseDiagram を

選択する。 

3 格納先のフォルダを選択す

る。 
parent folder 入力欄に選択したフ

ォルダ名が表示される。 

eclipse の基本操作 

ウイザードによる情報の入力を行なう。 

ダイアグラムを格納したいフォルダをウイザ

ードのツリーから選択する。 

4 作成するダイアグラムの

GMF ダイアグラム情報ファイ

ル名称を入力し、Next ボタ

ンを押下する。 

画面が遷移する。 eclipse の基本操作 

ウイザードによる情報の入力を行なう。 

D-Case ダイアグラムはダイアグラムファイ

ルとモデル情報ファイルで構成されている。

まずダイアグラムファイル名を入力する。 

5 作成するダイアグラムの

GMF モデル情報ファイルの

名称を入力し、Finish ボタン

を押下する。 

新しいダイアグラムが作成され、エ

ディタウインドウに開く。 

GMF モデル情報ファイル名の入力が完了

すると D-Case ダイアグラム(diagram、

model)が生成され、エディタウインドウ上に

表示される。 

表 2 ダイアグラム新規作成フロー 

2 . 2 .  ダイアグラムの読込み  

プロジェクトエクスプローラに表示されている D-Case の GMF ダイアグラム情報ファイルをダブルクリックす

ることで編集ウインドウに当該ダイアグラムが読込まれ、編集が可能な状態となる。 

2 . 3 .  ダイアグラムの保存  

「File」メニュー内の以下の項目を選択することによりファイル保存操作ができる。 

1. 「Save」項目 

選択している編集ウインドウの内容をモデル情報ファイル・ダイアグラム情報ファイルに保存 

2. 「Save As」項目 

選択している編集ウインドウの内容を別名でモデル情報ファイル、ダイアグラム情報ファイルに保存 

3. 「Save All」項目 

全ての編集ウインドウの内容を対応するモデル情報ファイル・ダイアグラム情報ファイルに保存 

 

2 . 4 .  ダイアグラムの名称変更 (Rename) 

 

ダイアグラムファイルとモデル情報ファイルをセットでファイル名を変更する。 

表示中のダイアグラムの場合、ファイル名を変更できない。 

変更後のダイアグラムファイルとモデル情報ファイルは、同一のファイル名を使用する（拡張子は別）。 
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ファイル名の変更フロー  
No .  操作  アクション 詳細 

1 Package Exploerer でダイアグラムファイ

ルを選択する。 
  

2 メニューバーか

ら”D-Case”>”File”>”Rename...”メニュ

ーを選択する 

ファイル名入力ダイアログを表示する。  

3 新しいファイル名を入力する   

3.1 “OK”ボタンを押下する ファイル名入力ダイアログを閉じる。 

ダイアグラムファイルとモデル情報ファイル

のファイル名を、入力されたファイル名に変

更する。 

 

3.2 “Cancel”ボタンを押下する ファイル名入力ダイアログを閉じる。  

表 3 ファイル名の変更フロー 

 

2 . 5 .  ダイアグラムのコピー (Copy To) 

 

ダイアグラムファイルとモデル情報ファイルをセットでコピーする。 

コピー先のダイアグラムファイルとモデル情報ファイルは、同一のファイル名を使用する（拡張子は別）。 

 

ファイルのコピーフロー  
No .  操作  アクション 詳細 

1 Package Exploerer でダイアグラムファイ

ルを選択する。 
  

2 メニューバーか

ら”D-Case”>”File”>”Copy To...”メニュ

ーを選択する 

ファイル名入力ダイアログを表示する。  

3 新しいファイル名を入力する   

3.1 “OK”ボタンを押下する ファイル名入力ダイアログを閉じる。 

ダイアグラムファイルとモデル情報ファイル

のファイル名を、入力されたファイル名にコ

ピーする。 

 

3.2 “Cancel”ボタンを押下する ファイル名入力ダイアログを閉じる。  

表 4 ファイル名のコピーフロー 
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3 .  編集機能 
3 .1 .  ダイアグラム編集  

パレットから要素を選択  

 

図 1 パレット上の要素表示 

パレットから選択したノードやリンクをキャンバス上に追加することが可能である。 

以下の要素をパレットに配置し、利用可能とする 

要素分類 要素名 備考 

GSN Nodes 

Goal  

Evidence  

Strategy  

Context  

Justification  

Assumption  

Undeveloped  

Module 動作は GSN Standard に準拠しない 

Contract 動作は GSN Standard に準拠しない 

D-Case Nodes 

Monitor  

System  

Policy  

Userdef001  

Userdef002  

Userdef003  

Links 

Supported By 矢印付き実線 

In Context Of 矢印付き（白抜き）実線 

Link 矢印無し実線 

Link 矢印無し点線 

表 5 パレット上の要素 
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ノード追加フロー 

No .  操作  アクション 詳細 

1 パレット上の任意のノードをク

リックする 
クリックしたノードが選択状態になる。  

2 キャンバスの、ノードを配置す

る位置をクリックする 
クリックした場所にノードが追加される。  

    

表 6 ノード追加フロー 

リンク接続フロー 

No .  操作  アクション 詳細 

1 パレット上のリンクをクリックす

る。 
リンクが選択状態になる。  

2 リンク元のノードをクリックし、リ

ンク先のノードまでドラッグ&ド

ロップする 

リンク元のノードからリンク先のノードまでリ

ンクが接続される。 

 

    

表 7 リンク接続フロー 

 

ポップアップメニューからノードを選択 

 

図 2 ポップアップメニュー 

 

図形編集領域内にマウスカーソルを置いてしばらくするとポップアップメニューが表示される。その中のア

イコンを選択することにより、アイコンに対応したノードを作成できる。 

「四角つき矢印」からリンク作成 
ノード外周部に表示されているリンク線の□部分をドラグしてリンクしたいノードと結ぶことによりリンクを作

成できる。 

図 3 四角つき矢印 

 

要素をコピー&ペースト 
ダイアグラム上の要素はコピー&ペーストすることができる。 
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編集したい要素を選択状態とした状態で、Edit メニューから Copy を選択すると要素のコピーができる。要

素を選択していない状態で Edit メニューから Paste を選択するとコピーされている要素をペーストできる。 

 

属性変更 
ノードの属性編集には以下の方法がある。 

1. 項目をクリックして選択し、表示されている文字をクリックし文字を変更する。 

2. 項目をクリックして選択し、「Properties View」に表示される属性の値を変更する。 

3. 項目をクリックして選択し、メニューバー・ボタンを選択し属性を変更する。 

 

「Properties View」が表示されていない場合、図形編集領域を右クリックして表示されるメニューより

「Show Properties View」を選択すると「Properties View」が表示される 

 

属性入力ダイアログからの属性変更 
属性入力ダイアログにて属性を設定することを可能とする。 

属性入力フロー 

No .  操作  アクション 詳細 

1 ダイアグラム上でノ

ードをひとつ選択す

る 

  

2 ダブルクリックまたは

Enter キーを押下す

る 

属性入力ダイアログを表示する  

3 属性を入力する   

4.1 “OK”ボタンを押下

する 
属性入力ダイアログを閉じて属性を更新す

る 

 

4.2 “Cancel”ボタンを押

下する 
属性入力ダイアログを閉じる  

表 8 属性入力フロー 

 

 

ノード・リンク削除 
ノード・リンクの削除には項目をクリックして選択し、以下方法で削除できる。 

1. BS キー押下 

2. DELETE キー押下 

3. Edit メニューより「Delete」を選択 

4. 項目上で右クリックしコンテキストメニューより「Delete from Model」を選択 

※Argument も削除可能であるが、子要素も同時に削除される。また、それ以降ダイアグラムの編
集を継続できなくなる。 
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3 . 2 .  テンプレートを利用したダイアグラム編集  

テンプレートビューの表示  
操作対象の Eclipse ワークスペース内に、テンプレートプロジェクトがあらかじめ配備されているものとす

る。 

・	 テンプレートプロジェクト内の構成は、D-Case エディタプラグインとは独立して、任意のタイミン

グで変更可能とするが、最新状態を反映させるためには、テンプレートビューを開き直すものと

する。 

 

テンプレートビュー表示フロー 

No .  操作  アクション 詳細 

1 “Show View”ダイア

ログを表示する 
“Show View”ダイアログが表示される メニューから”Window” >> “Show View” >> 

“Other”を選択する 

 

2 テンプレートビューを

選択する 
”Template Selection View”が選択状態に

なる 

“D-Case Editor”カテゴリから”Templates”

を選択する 

3 OK ボタンをクリック

する 
テンプレートビューが表示される  

表 9 テンプレートビュー表示フロー 
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テンプレートダイアグラムを新規作成 
テンプレートとしての D-Case ダイアグラムを新規に作成するためには、あらかじめテンプレートを格納する
ためのプロジェクトフォルダが作成されている必要がある。 

テンプレートダイアグラム新規作成フロー  

No .  操作  アクション 詳細 

1 eclipse の File メニューから

New→Other...を選択する。 
New ウイザードが表示される eclipse の基本操作 

ウイザードを起動する。 

2 D-CaseEditor カテゴリの

D-Case Diagram を選択し、

Next ボタンを押下する。 

D-Case Diagram が選択され画面

が遷移する。 

eclipse の基本操作 

ウイザードによる情報の入力を行なう。 

新規作成の対象として D-CaseDiagram を

選択する。 

3 格納先のフォルダに

D-CaseTemplate プロジ

ェクト内の任意のフォル

ダを選択する。 

parent folder 入力欄に選択したフ

ォルダ名が表示される。 

eclipse の基本操作 

ウイザードによる情報の入力を行なう。 

あらかじめ D-CaseTemplate フォルダを作

成しておく必要がある。 

4 作成するダイアグラムの

GMF ダイアグラム情報ファイ

ル名称を入力し、Next ボタ

ンを押下する。 

画面が遷移する。 eclipse の基本操作 

ウイザードによる情報の入力を行なう。 

D-Case ダイアグラムはダイアグラムファイ

ルとモデル情報ファイルで構成されている。

まずダイアグラムファイル名を入力する。 

5 作成するダイアグラムの

GMF モデル情報ファイルの

名称を入力し、Finish ボタン

を押下する。 

新しいダイアグラムが作成され、エ

ディタウインドウに開く。 

GMF モデル情報ファイル名の入力が完了

すると D-Case ダイアグラム(diagram、

model)が生成され、エディタウインドウ上に

表示される。 

表 10 テンプレートダイアグラム新規作成フロー 

 

テンプレートダイアグラムを編集 
 

テンプレート編集フロー 

No .  操作  アクション 詳細 

1 テンプレートダイアグ

ラムを開く 
テンプレートダイアグラムが表示される 作成済みのテンプレートダイアグラムを開く 

通常の D-Case ダイアグラムの作成と同様 

2 要素を追加・編集・

削除する 
ダイアグラムが変更される 通常の D-Case ダイアグラムの編集作業と

同様 

3 保存する ダイアグラム情報ファイル、GMF モデル情

報ファイルが保存される。 

GMF モデル情報ファイルがテンプレートとし

て利用される 

表 11 テンプレート編集フロー 

 

テンプレートからダイアグラムへ要素を追加 
テンプレートからダイアグラムに要素を追加するには、以下の手順で実行する。 

・	 テンプレートから追加される要素（群）は、選択状態となっている。 
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・	 テンプレートから追加される要素（群）は、ダイアグラムの中央付近に配置される。（配置位置を

指定して追加する機能はない） 

 

テンプレート追加フロー 

No .  操作  アクション 詳細 

1 テンプレートを追加

したいダイアグラム

をアクティブにする 

対象ダイアグラムがアクティブになる 以下のいずれかの操作を実行する 

・新規に D-Case ダイアグラムを作成する 

・既存の D-Case ダイアグラムを開く 

・非アクティブ状態のダイアグラムをアクティ

ブにする 

新規作成または既存のダイアグラムを開い

た場合、ダイアグラムのキャンバスを 1 回ク

リックする 

アクティブな D-Case エディタがない場合は

例外処理を実行する 

2 テンプレートを選択

する 
テンプレートビュー内で、テンプレートが選

択状態になる 

ツリー構造を展開して、パターンまたはライ

ブラリをクリックして選択する 

一度に複数のテンプレートを選択すること

はできない 

ツリー構造の途中のフォルダを選択してい

る状態はテンプレートが選択されている状

態とはならない 

3 テンプレートを追加

する 
ダイアグラム上に、自動整列された状態で

テンプレートが追加される 

追加された要素（群）は選択状態となって

いる 

ファイルが更新状態となり、「*」マークがつ

く 

テンプレートにパラメータが設定されている

ノードが含まれている場合、パラメータ値入

力ダイアログを表示し、入力が完了したら

テンプレートがダイアグラムに追加される。 

テンプレートビューのツールバーのアイコン

（プラス記号）をクリックする 

または、テンプレートビューのプルダウンメ

ニューから「Add Template」を選択する 

表 12 テンプレート追加フロー 
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 テンプレートビューからダイアグラムへ要素を追加  

 

 

図 4 パラメータ構成ダイアログ 
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3 . 3 .  アタッチメントファイルの設定  

すべてのノードに対して、Attachment を設定できるものとする。 

Attachment 

Attachment は以下の場所から選択することができる。 

・Workspace 

・Web 

 

・Workspace からの選択  
Workspace から Attachment を選択するには、はノード、あるいはキャンバスのコンテキストメニューを表示

し、 

“Attachment” > “Select from Ｗorkspace”メニューを選択する 

 

・Web からの選択  
Web から Attachment を選択するには、はノード、あるいはキャンバスのコンテキストメニューを表示し、 

“Attachment” > “Select from Web”メニューを選択する 

 

Web Browser ダイアログでは、Bookmarks に設定されている Bookmark から表示する URL を選択できる。 

サブツリーの一括選択  
選択したノードから連なるノードを全て選択状態にする。 

1. 特定のノードを選択して右クリックし、コンテキストメニューを表示する。 

2. メニューから”Select subtree”を選択する。 
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3 . 4 .  パラメータ 
ノードに対してパラメータを設定することが可能である。 

設定されたパラメータは Desc に設定する文字列のフォーマッティングやスクリプト生成に使用可能とす
る。 

 

パラメータの構成  
各ノードおよび Argumentに対してパラメータを構成できるものとする。Argumentにて構成されたパラメー
タはグローバルパラメータとして取り扱い、ダイアグラム内のすべてのノードから参照できるものとする。 

 

パラメータ構成フロー 

No .  操作  アクション 詳細 

1 ダイアグラム上でノードをひとつあるい

は Argument を選択し右クリックする 
コンテキストメニューが表示される。  

2 コンテキストメニューから“Ｐａｒａｍｅ

ｔｅｒｓ”＞”Configure Parameters”

を選択する。 

パラメータ構成ダイアログが表示される。  

3 パラメータ構成を設定する   

4.1 “OK”ボタンを押下する パラメータ構成ダイアログを閉じ、パラメータ構成を

更新する.。 

 

4.2 “Cancel”ボタンを押下する パラメータ構成ダイアログを閉じる。.  

表 13 パラメータ構成フロー 
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パラメータ構成ダイアログ  

 

図 5 パラメータ構成ダイアログ 

 

パラメータ値の設定  
 

パラメータ構成されているノードは、パラメータ構成に従ってパラメータの値を設定できる。グローバルパラ

メータとして利用されているパラメータの値は、Argument でのみ変更できる。 

 

 

属性 値  設定内容 例  

Userdef005 Desc 用フォ

ーマット文字

列 

｛パラメータ名｝と

文字列の組み合

わせ 

入力例：CPU 使用率が{CPU}以下である 

Desc 表示例：CPU 使用率が 60 以下である 

Userdef006 スクリプト ｛パラメータ名｝と

文字列の組み合

わせ 

 

Userdef007 パラメータ パラメータ名=パラ

メータ値をカンマ

区切りで設定する 

この属性に設定さ

れているパラメー

タについて、値の

入力、Desc 用フォ

ーマット文字列での

入力例：CPU=60 
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属性 値  設定内容 例  

利用を可能とする 

“id”はノードの id

を示す予約語で

あるためパラメー

タには使用できな

い 

表 14 Goal ノードの属性  

 

 

 

パラメータ値設定フロー 

No .  操作  アクション 詳細 

1 ダイアグラム上でパラメータ構成されて

いるノードをひとつあるいはキャンバス

選択し右クリックする 

コンテキストメニューが表示される。  

2 コンテキストメニューか

ら”Parameters”>”Set 

Parameters”を選択する。 

パラメータ値設定ダイアログが表示される。  

3 パラメータ値を設定する   

4.1 “OK”ボタンを押下する パラメータ値ダイアログを閉じ、パラメータ値を更新

する.。 

Desc をフォーマット文字列とパラメータ値にしたがっ

て更新する。 

グローバルパラメータ値が設定された場合は、それ

を利用しているノードの Desc も更新する。 

 

4.2 “Cancel”ボタンを押下する パラメータ値ダイアログを閉じる。.  

表 15 パラメータ値設定フロー 

パラメータ設定ダイアログ  

 

図 6 パラメータ値設定ダイアログ 
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3 . 5 .  Va l i d a t i o n 実行  
・ノード間リンクのチェックをする 

・ノードとリンクの属性値のチェックをする 

・ダイアグラム全体および一部での循環構造をチェックする 

・検出可能なエラーを全て検出し、箇所と内容を eclipse のビューへマーカーを表示する 

・表示したマーカーは Validation を再実行する際にクリアをする 

 Va l i d a t i o n 実行  

 

 

図 7 Validation 実行 
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Va l i d a t i o n 実行結果  

 

 

・Validation 機能はチェックする項目を Preference から設定可能とする 

Va l i d a t i o n 機能設定  

図 8 Validation 実行結果 

図 7 Preferences ダイアログ内の Validation 機能設定 
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検証ルール 

ノード接続の多重度 

  Target 

 	  

Goal , 

System 

Undevelope

d Strategy Evidence Monitor Context 

Justif icatio

n その他  

Source Goal , 

System - 1..* ： 0..1 1..* ： 0..1 1..* ： 0..1 1..* ： 0..1 0..1 ： 0..* 1 ： 0..* 0..* ： 0..* 

Undeveloped - - - - - - - 0..* ： 0..* 

Strategy 1..* ： 1..* - - - - 0..1 ： 0..* - 0..* ： 0..* 

Evidence - - - - - 0..1 ： 0..* - 0..* ： 0..* 

Monitor - - - - - 0..1 ： 0..* - 0..* ： 0..* 

Context - - - - - - - 0..* ： 0..* 

Justif ication - - - - - - - 0..* ： 0..* 

その他  0..* ： 0..* 0..* ： 0..* 0..* ： 0..* 0..* ： 0..* 0..* ： 0..* 0..* ： 0..* 0..* ： 0..* 0..* ： 0..* 

 

表 16 ノード接続の多重度 
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ただし、Ｇｏａｌからの接続は以下の制約がある。 

・	 Goal は Undeveloped, Strategy, Evidence, Monitor に対して同時に接続することはできない 

・	 Justification は Evidence, Monitor に接続されている Goal から接続することはできない 

また、Context への接続は以下の制約がある。 

・	 1 つの Context に対しては、Goal, Strategy, Evidence, Monitor のうち、1 つのノードからのみ接続
できる 

 

 

Goal および System からの接続ルールについてのデシジョンテーブルを以下に示す。 

条件 

Strategy への接続 Y Y Y Y Ｎ - - Ｎ - - Ｎ - Ｎ 

Undeveloped への接続 Ｎ Y - - Y Y Y Ｎ - - Ｎ - - 

Evidence への接続 Ｎ - Y - Ｎ Y - Y Y Y Ｎ - Ｎ 

Monitor への接続 Ｎ - - Y Ｎ - Y Ｎ Y - Y Y Ｎ 

Context への接続 - - - - - - - - - - - - - 

Justif ication への接続 - - - - Ｎ - - Ｎ - Y Ｎ Y - 

動作 Validation 実行のエラー表示 Ｎ Ｙ Ｙ Ｙ Ｎ Ｙ Ｙ Ｎ Ｙ Ｙ Ｎ Ｙ Ｎ 

表 17 Goal からの接続の制約（デシジョンテーブル） 

 

Context への接続ルールについてのデシジョンテーブルを以下に示す。 

条件 

Goal, System からの接続 Y Y Y Y Ｎ - - Ｎ - Ｎ 

Strategy からの接続 Ｎ Y - - Y Y Y Ｎ - Ｎ 

Evidence からの接続 Ｎ - Y - Ｎ Y - Y Y Ｎ 

Monitor からの接続 Ｎ - - Y Ｎ - Y Ｎ Y Y 

動作 Validation 実行のエラー表示 Ｎ Ｙ Ｙ Ｙ Ｎ Ｙ Ｙ Ｎ Ｙ Ｎ 

表 18 Context からの接続の制約（デシジョンテーブル） 

 

ノード属性値のチェック 

Goal/System ノードの Weight 属性値が 1 以上であること。
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3 . 6 .  評価点計算  
ディペンダビリティを測定するために、Evidence の接続状態や重みを基に、ゴールの評価点を以下のよう

に計算する。 

 

・サブゴールがあるゴール  (サブゴールの得点*サブゴール重み)の和/サブゴール重みの和 

・サブゴールがないゴール  Evidence が与えられていれば 1、そうでなければ 0 

 

・	 評価点計算上は、System ノードは Goal ノードと同等に扱う。 

・	 評価点計算上は、Monitor ノードは Evidence ノードと同等に扱う。 

・	 計算結果は Score(評価点)プロパティに設定する。 

・	 計算実行時にすべての Goal、System の評価点を初期化する。初期値は 0 とする。 

 

ゴールの評価点計算のパターンについてのデシジョンテーブルを以下に示す。 

 

条件 

Goal、System から Strategy が接続されている - - - Y Y Y Ｎ N 

Goal、System から Evidence または Monitor が接続されている - - - N Y - Ｙ N 

Goal、System から Undeveloped が接続されている - - - N - Y - - 

Goal、System から複数の Strategy が接続されている Y - - N N N Ｎ N 

重みが 1 以上の整数ではない - Y - N N N Ｎ N 

循環して接続されている（（Goal、System）,Strategy のみチェック） - - Y N N N Ｎ N 

動作 
評価点 0 0 null ＊1 0 0 1 0 

計算処理を中止し、エラー表示 Y Y Ｎ N Y Y Ｎ N 

表 19 評価点の計算 

＊1  (サブゴールの得点*サブゴールの重み)の和/サブゴールの重みの和 サブゴールがない場合は 0

とする。 

サブゴールとは Goal、System から Strategy を経由して接続されている Goal、System である。 

デシジョンテーブルに記載されていないパターンにおいては、評価点の計算およびエラー表示を行わな

い。 

 

評価点計算フロー 

No .  操作  アクション 詳細 

1 キャンバス上で右

クリックし、ポップ

アップメニューを

表示する 

ポップアップメニューが表示される  

2 “Calculate the 

Score”を選択す

る 

各ゴールの評価点が計算され、Score に結

果が設定される 

 

表 20 評価点計算フロー 
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評価点計算実行  

 

図 10 評価点計算の実行 
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3 . 7 .  補完  

ノードに接続する子ノードの候補を選択する機能を提供する。 

子ノードは新規ノードあるいはテンプレートから選択する。 

 

新規ノードを追加  
選択されているノードに対して子ノードとして接続可能なノードを候補として表示する。 

 
ノード追加フロー 

No .  操作  アクション 詳細 

1 パレット上の任意のノードを右クリック

する 
コンテキストメニューが表示される。  

2 コンテキストメニューから“Add 

Child”→”Create a New Node”を

選択する 

コンテキストメニューに追加可能なノ

ードの一覧が表示される。 

 

3 追加するノードを選択する 新規ノードが追加され、選択している

ノードから追加したノードへリンクされ

る。 

 

表 21 ノード追加フロー 

 

テンプレートから追加  
選択されているノードに対して、定義ファイルによって関連付けられているテンプレートを候補として表示

する 

 

テンプレートから追加フロー 

No .  操作  アクション 詳細 

1 パレット上の任意のノードを右クリック

する 
コンテキストメニューが表示される。  

2 コンテキストメニューから“Add 

Child”→”Add a Template”を選択

する 

コンテキストメニューに、定義ファイル

で関連付けられたテンプレートの一覧

が表示される。 

 

3 追加するテンプレートを選択する テンプレートが追加される。  

表 22 テンプレートから追加フロー 
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テンプレートとノードの関連付け 
ノードとテンプレートの関連付けは、定義ファイルによって行う。 

以下の条件を満たすダイアグラムを、補完の候補として利用できるものとする。 

ノードの種類 

ノードの Desc 属性に含まれるキーワード（カンマ、ピリオド、スペース区切り）のいずれかが、タグと一致す

る。 

以下に定義ファイルのスキーマを示す。 

 

<?xml	 version="1.0"	 encoding="utf-8"?>	 

<xs:schema	 

targetNamespace="http://www.dependable-os.net/2010/09/dcase/complement"	 

elementFormDefault="qualified"	 

xmlns="http://www.dependable-os.net/2010/09/dcase/complement"	 

xmlns:mstns="http://www.dependable-os.net/2010/06/dcase/complement"	 

xmlns:xs="http://www.w3.org/2001/XMLSchema"	 version="0.3.0">	 

	 	 <xs:element	 name="ComplementChoices">	 

	 	 	 	 <xs:complexType>	 

	 	 	 	 	 	 <xs:sequence>	 

	 	 	 	 	 	 	 	 <xs:element	 name="Template"	 maxOccurs="unbounded"	 minOccurs="0">	 

	 	 	 	 	 	 	 	 	 	 <xs:complexType>	 

	 	 	 	 	 	 	 	 	 	 	 	 <xs:sequence>	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:element	 name="tags"	 maxOccurs="1"	 minOccurs="1">	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:complexType>	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:sequence>	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:element	 name="tag"	 type="xs:string"	 maxOccurs="unbounded"	 

minOccurs="0"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 </xs:sequence>	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 </xs:complexType>	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 </xs:element>	 

	 	 	 	 	 	 	 	 	 	 	 	 </xs:sequence>	 

	 	 	 	 	 	 	 	 	 	 	 	 <xs:attribute	 name="type"	 use="required">	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:simpleType>	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:restriction	 base="xs:string">	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Goal"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Strategy"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Evidence"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Undeveloped"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Context"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Monitor"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Justification"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="System"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Policy"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Userdef001"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Userdef002"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Userdef003"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Assumption	 "	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Contract	 "	 />	 
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	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="Module	 "	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 <xs:enumeration	 value="All"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 	 </xs:restriction>	 

	 	 	 	 	 	 	 	 	 	 	 	 	 	 </xs:simpleType>	 

	 	 	 	 	 	 	 	 	 	 	 	 </xs:attribute>	 

	 	 	 	 	 	 	 	 	 	 	 	 <xs:attribute	 name="path"	 type="xs:string"	 use="required"	 />	 

	 	 	 	 	 	 	 	 	 	 	 	 <xs:attribute	 name="name"	 type="xs:string"	 />	 

	 	 	 	 	 	 	 	 	 	 </xs:complexType>	 

	 	 	 	 	 	 	 	 </xs:element>	 

	 	 	 	 	 	 </xs:sequence>	 

	 	 	 	 </xs:complexType>	 

	 	 </xs:element>	 

</xs:schema>	 

 

No 名称  型  内容  

1 ComplementChoices 要素 補完機能で表示する選択肢。 

Templete：テンプレート。 

2 Template 要素 補完機能で表示するテンプレート。 

tags：タグのリスト。指定がない場合はノードの種類
のみで関連付ける。 

＠ type：ノードの種類 

@path：テンプレートのパス。 

@name：表示名。コンテキストメニューに表示する。 

3 tag 要素 タグ。 

表 23 補完候補定義ファイル スキーマ詳細 

定義ファイルの配置場所  

D-CaseTemplate プロジェクト/Complement.xml 

 

3 . 8 .  兄弟順序の設定  
Strategy を source とするリンクについて、兄弟間での順序を設定する。 

兄弟順は target ノードの x 座標の値が小さい順に振る。x 座標が同じ場合は y 座標の値が小さい順と
する。 

 

兄弟順序設定フロー 

No .  操作  アクション 詳細 

1 ダイアグラム上の Strategy ノードをひと

つ選択し、右クリックする 
コンテキストメニューが表示される。  

2 コンテキストメニューから”Set 

Sibling Order”を選択する 
選択したノードを source とするリンクに兄弟順序が

設定される。 

 

表 24 兄弟順序設定フロー 
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3 . 9 .  要件管理機能  
Context に、システムの要件を複数設定することを可能にする。 

各 Goal には、その Goal がどの要件に関連したものかを設定することができる。 

 

 

設定  
Context のコンテキストメニューを表示し、“Set Requirements…”メニューを選択することにより、要件設
定ダイアログを表示する。 

Requirement には、グローバルパラメータをフォーマット識別子として使用することができる。 

ex) 

同時ログインユーザ数は{LoginUserCount }である。 

 

Context の Desc Format String に以下のフォーマット指定子を使用することにより、設定された要件を
Desc に表示する。 

{Requirements} 

 

Desc への表示は以下の形式とする 

Requriement1 

Requriement2 

     ・ 

     ・ 

     ・ 

Requriementn 

 

 

関連付け 
Goal の属性設定ダイアログにて、すべての要件の中から関連付ける要件を選択する。 

 

確認  
メニューバーより以下のメニューを選択し Requirements View を表示する。 

“Window”＞“Show View”>“Other…”>“D-Case Editor”>“Requirements” 
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3 . 1 0 .  自動整列  
編集中のダイアグラムのノード位置を自動整列させる。 

 

リンクにしたがってツリー状に整列させる。 

同一の source ノードに接続されるノードは、source ノードの下に Sibling Order が若い順に縦方向の場
合は左から、横方向の場合は上から配置する。Sibling Order の指定が無いノードは、name プロパティ
のソート順に配置する。ただし、Contex ノード、Justification は縦方向の場合は source ノードの右側に、
横方向の場合は下に配置する。 

name プロパティのソート順は以下の通りとする。 

・	 数値が出てくるまでの文字列を辞書順で比較する。 

・	 上記で一致する場合は、さらに数値部分を大小比較する。 

 

 

自動整列フロー  

No .  操作  アクション 詳細 

1 メニューバー

の”Diagram”>”Arrange”>”All”

を選択する 

ダイアグラム全体を自動整列 デフォルトの整列方向は縦。方向

指定の整列を行った後は、その方

向で整列する。 

表 25 自動整列フロー 

方向指定自動整列フロー  

No .  操作  アクション 詳細 

1 キャンバスの右クリックでコンテ

キストメニューを表示 
  

2.1 “Arrange”>”Vertical”を選択

する 
ダイアグラム全体を縦方向に自動

整列 

 

2.2 “Arrange”>”Hrizontal”を選択

する 
ダイアグラム全体を横方向に自動

整列 

 

表 26 方向指定自動整列フロー 
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4 .  表示機能 
4 .1 .  拡大・縮小  
図形編集領域の表示を拡大・縮小するには以下の方法がある。 

1. メニュー領域より 

編集ウインドウを選択し、表示される「Diagram」メニュー内の「Zoom」サブメニュー内の項目をクリッ

クすることにより拡大・縮小できる。 

 

2. ボタン領域より 

ボタン領域内に表示される倍率メニュー内の項目をクリックすることにより拡大・縮小できる。 

 

3. パレット領域より 

パレット領域上部に表示される拡大・縮小アイコンをクリックすることにより拡大・縮小できる。 

 

4. 図形編集領域より 

図形編集領域内で、ノード・リンクを未選択の状態で右クリックし表示されるコンテキストメニュー内

の「Zoom」サブメニュー内の項目をクリックすることにより拡大・縮小できる。 

 

 

ノードを選択した状態で、Diagram メニューより「Diagram>Zoom>Fit to Selection」を選択することにより、

選択した項目が図形編集領域に全て入りきるように表示が拡大される。 

 

4 . 2 .  表示部分変更  
図形編集領域に表示されている部分と全体の関係は「Outline View」に表示されている。 

「Outline View」内の灰色の部分は図形編集領域に表示されている部分である。 

図形編集領域に表示されている部分を変更するには以下の方法がある。 

1. 図形編集領域より 

図形編集領域のスクロールバーを操作すると、図形編集領域に表示される部分が変更される。 

2. 「Outline View」より 

「Outline View」内の灰色の部分をドラグすると図形編集領域の表示内容が変更される。 
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4 . 3 .  子ノードの折りたたみ 
任意のノードを選択し、コンテキストメニューから子ノード全体の表示・非表示を切り替える。 

・	 子ノードの折りたたみは D-Case エディタで定義したノードに対して実行を可能とする。一般図

形からの実行は不可とする。 

・	 子ノードを非表示にした状態のノードは、背景色を変更して認識可能にする。 

・	 非表示から表示への切り替えは、非表示の子ノード配下だけを対象にする。既に表示されて

いる子ノードは対象外とする。 

・	 子ノードを非表示にした状態は保存せず、ファイルを開き直した時は全てのノードとリンクを表

示した状態にする。 

・	 アウトラインビューのツリー表示では常にすべてのノードを表示する。 

・	 非表示のノードは印刷されない。印刷範囲は非表示のノードの領域を含めて設定される。 

子ノードの折りたたみフロー 

No .  操作  アクション 詳細 

1 ノードのコンテキ

ストメニューから

“Show/Hide 

Children”を選択

する 

“Show/Hide Children”メニュー項目を選択

すると“Hide Children”と“Show Children”

サブメニューが表示される 

 

2 カスケードしたサ

ブメニューから

“Hide Children”

を選択する 

選択したノードの背景色が変更され、子ノ

ードが全て非表示となる 

 

表 27 子ノードの折りたたみフロー 

 子 ノードの表示フロー 

No .  操作  アクション 詳細 

1 ノードのコンテキ

ストメニューから

“Show/Hide 

Children”を選択

する 

“Show/Hide Children”メニュー項目を選択

すると“Hide Children“と”Show Children

“サブメニューが表示される 

 

2 カスケードしたサ

ブメニューから

“Show Children”

を選択する 

選択したノードの背景色がデフォルト色

（白）に変更され、子ノードが全て表示され

る 

ユーザにより背景色が変更されている場

合、その色情報は保持しない。 

表 28 子ノードの表示フロー 

＊	 非表示のノードを選択するには、Outline View でノードを選択する。非表示ノードは Select All の対

象外となる 
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子ノードの折りたたみ実行  

 

 

子 ノードの表示実行  

 

 

 

 

図 8 子ノードの折りたたみ実行 

図 9 子ノードの表示実行 
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4 . 4 .  System ノード  

参照先 D-Case ダイアグラムの設定および表示を行う。 

参照先ダイアグラムの設定  
参照先選択フロー 

No .  操作  アクション 詳細 

1 パレット上の任意の System ノードを右

クリックする 
コンテキストメニューが表示され

る。 

 

2 コンテキストメニューから”Node 

Link”→“Select a Workspace...”を

選択する 

参照先選択ダイアログが表示さ

れる。 

ワークスペース内の D-Case ダイア

グラムを表示する。 

3.1 参照先選択をキャンセルする 参照先選択ダイアログを閉じ

る.。 

 

3.2 参照先を選択する 参照先選択ダイアログを閉じる 

System ノードに選択された参照

先が設定される。 

 

表 29 参照先選択フロー 

参照先ダイアグラムの表示  
参照先表示フロー 

No .  操作  アクション 詳細 

1 パレット上の任意の System ノードを右

クリックする 
コンテキストメニューが表示され

る。 

 

2 コンテキストメニューから“Node 

Link”→“Open with D-Case 

Editor”を選択する 

参照先のダイアグラムが表示さ

れる。 

 

表 30 参照先表示フロー 

 

4 . 5 .  Attachment を開く  
すべてのノードの Attachment 属性に入力されている Workspace のファイルあるいは URL を開く。 

すべての種類のノードの Attachment 属性をエディタでの表示対象とする。 

*Argument ノードを対象とする場合はキャンバスを指定する。 

デフォルトエディタでの表示は以下の手順で実行する。 

 

デフォルトエディタでの表示フロー 

No .  操作  アクション 詳細 

1 任意のノードを右

クリックする 
コンテキストメニューが表示される  

2 ノードのコンテキ

ストメニューから

“Attachment”→

“Open”を選択す

 

ＡｔｔａｃｈｍｅｎｔがＵＲＬ形式で設定されてい

る場合はブラウザで開く 

上記以外はデフォルトエディタで表示する。 
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No .  操作  アクション 詳細 

る 

表 31 デフォルトエディタでの表示フロー 

 

 

 

4 . 6 .  差分表示  
 

比較対象の元ファイル（モデル）を指定し、そのファイルとの差分を表示する。 

すべてのリンクおよびノードについて、以下の変更を検出する。 

・	 新規追加 - 現ファイルに存在する ID が元ファイルに存在しない 

・	 更新 - 同一 ID のノード、リンクの属性が元ファイルと現ファイルで違う 

・	 削除 - 元ファイルに存在する ID が現ファイルに存在しない 

検出した差分は以下のように表示する。 

ダイアグラム上 

・	 新規 - ノードの枠、リンクの線の色を青にする 

・	 更新 - ノードの枠、リンクの線の色を赤にする 

・	 変更なし - 黒 

コンソール上  

コンソールにはダイアグラムでは表示できない情報をテキストで表示する。 

・Argument 比較結果（変更がある場合のみ出力） 

Argument changed. 

 

・削除されたノードの情報 

Node: "ノード名"[parents:"親ノード名"] deleted. 

・削除されたリンクの情報 

Link: "リンク名"[source:"source ノード名"][target:"target ノード名"] deleted. 

 

 

 

 

 

 



D-Caseエディタ機能仕様書 

 37 

差分表示フロー  

No .  操作  アクション 詳細 

1 メニューバーか

ら”D-Case”>”File”>”Compare 

To,,,”を選択する。 

ダイアグラムファイル選択ダイアロ

グが表示される 

 

2 比較対象のダイアグラムファイ

ルを選択する。 
差分がダイアグラム上およびコンソ

ールに表示される。 

 

表 32 差分表示フロー 

 

ダイアグラム上に差分を表示中、Source ファイルと Target ファイルを入れ替えて差分を表示することがで

きる。 

Sou r c e -Ta r g e t 入れ替えフロー 

No .  操作 アクション 詳細 

1 ダイアグラム a を表示する。   

2 ダイアグラム b との差分をダイア

グラム a 上に表示する。 
  

3 メニューバーか

ら”D-Case”>”File”>”Switch 

Source and Target,”を選択す

る。 

ダイアグラム b を表示し、

ダイアグラム a との差分を

検出・表示する。 

 

表 33 Source-Target 入れ替えフロー 

 

4 . 7 .  検索・置換  

編集中のダイアグラムのすべてのノードの Desc から、指定されたキーワードを検索・置換する。 

メニューバーより以下のメニューを選択し Find/Replace ダイアログを表示する。 

“D-Case”＞“Find/Replace” 

 

検索開始位置は、1 つノードが選択されていればそのノードから、それ以外は左側にあるツリーの上位か

らとする。検索方向は Forward のみとする。 

Find は Name と Desc のみ。Replace については Desc Format String において相当する箇所を Replace

する。Parameters は Replace しない（検索対象としない）。 

Find でマッチした場合は、Set Properties ダイアログを表示し、Desc の、match した substring を選択す

る。 

"Replace","Replace/Find"は Find で match した場合のみ enable,キーワードが変更されると disable とな

る。 

 

 

4 . 8 .  ノード種別変換  

すべてのノード間でのノード種別変換を可能とする。 

変換の実行は、変換対象のノードを選択してコンテキストメニューを表示し、 
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“Convert Node Type” > 変換後のノード種別  

 

を選択する。 

 

変換後、id および name は新規発行し、その他の属性は元ノードからコピーする。 

 

元ノードに、変更後のノードに存在しない属性がある場合は Userdef008 に 

 

プロパティ名=プロパティ値  

 

をカンマ区切りで追加する。すでに Userdef008 に値がある場合も、すでに存在する値にカンマ区切りで追

加する。 
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5 .  入出力機能 
5 .1 .  変換  

GMF モデル情報ファイルから D-Case モデル情報ファイルへの変換 
GMF モデル情報ファイルを D-Case モデル情報ファイルに変換することができる。 

 

GMF モデル情報ファイルから D-Case モデル情報ファイルへの変換操作フロー  
No .  操作  アクション 詳細 

1 eclipse の“D-Case”メニューから

“Convert D-Case File”→“From GMF to 

D-Case”を選択する。 

Convert Model to D-Case ウイザ

ードが表示される 

ウイザードが起動する。 

2 Browse ボタン押下でファイル選択ダイア

ログを表示し、変換元となる GMF モデル

情報ファイル名、変換後の D-Case モデ

ル情報ファイル名を指定する。 

ウイザード画面にそれぞれのファイ

ル名が表示される。 

ウイザードによる情報の入力

を行なう。 

3 Finish ボタンを押下する。 変換処理が実行され、D-Case モ

デル情報ファイルが作成される。 

D-Case モデル情報ファイル

を作成する。 

表 34 GMF モデル情報ファイルから D-Case モデル情報ファイルへの変換操作フロー 

 

D-Case モデル情報ファイルから GMF モデル情報ファイルへの変換  
D-Case モデル情報ファイルを GMF モデル情報ファイルに変換することができる。 

 

＊属性値の型が正しくない場合は規定値を設定する 

＊整数型の属性値に小数点がある場合は、小数点以下は切り捨てとする 

D-Case モデル情報ファイルから GMF モデル情報ファイルへの変換操作フロー 

No .  操作  アクション 詳細 

1 eclipse の“D-Case”メニューから

“Convert D-Case File”→“From D-Case 

to GMF”を選択する。 

Convert Model to GMF ウイザード

が表示される 

ウイザードが起動する。 

2 Browse ボタン押下でファイル選択ダイア

ログを表示し、変換元となる D-Case モデ

ル情報ファイル名、変換後の GMF モデル

情報ファイル名を指定する。 

ウイザード画面にそれぞれのファイ

ル名が表示される。 

ウイザードによる情報の入力

を行なう。 

3 Finish ボタンを押下する。 変換処理が実行され、GMF モデル

情報ファイルが作成される。 

GMF モデル情報ファイルを作

成する。 

表 35 D-Case モデル情報ファイルから GMF モデル情報ファイルへの変換操作フロー 

 

 

D-Case モデル情報ファイルから ARM 形式ファイルへの変換  
D-Case モデル情報ファイルを ARM 形式ファイルに変換することができる。 

 

D-Case モデル情報ファイルから ARM 形式ファイルに変換する処理フロー 

No .  操作  アクション 詳細 

1 eclipse の“D-Case”メニューから

“Convert D-Case File”→“From D-Case 

to ARM”を選択する。 

Convert Model to ARM ウィザード

が表示される 

ウィザードが起動する。 

2 Browse ボタン押下でファイル選択ダイア ウィザード画面にそれぞれのファイ ウィザードによる情報の入力
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No .  操作  アクション 詳細 

ログを表示し、変換元となる D-Case モデ

ル情報ファイル名、変換後の ARM 形式

情報ファイル名を指定する。 

ル名が表示される。 を行なう。 

3 Finish ボタンを押下する。 変換処理が実行され、ＡＲＭ形式

ファイルが作成される。 

ＡＲＭ形式ファイルを作成す

る。 

表  36  D-Case モデル情報ファイルから ARM 形式ファイルに変換するフロー 

 

D-Case モデル情報ファイルから XSL 変換  
D-Case モデル情報ファイルを XSL 変換することができる。 

 

D-Case モデル情報ファイルから XSL 変換する処理フロー 

No .  操作  アクション 詳細 

1 eclipse の“D-Case”メニューから

“Convert D-Case File”→“XSL 

Transform From GMF Model”を選択す

る。 

登録されているConverterがサブメ

ニューに表示される 

 

2 サブメニューから Converter を選択する  ウィザードが起動する。 

3 Browse ボタン押下でファイル選択ダイア

ログを表示し、変換元となる D-Case モデ

ル情報ファイル名、変換後のファイル名

を指定する。 

ウィザード画面にそれぞれのファイ

ル名が表示される。 

ウィザードによる情報の入力

を行なう。 

4 Finish ボタンを押下する。 変換処理が実行される。  

表  37  D-Case モデル情報ファイルから XSL 変換する処理フロー 

 

5 . 2 .  ダイアグラム自動生成  

GMF モデル情報ファイルから GMF ダイアグラムファイル生成  
GMFモデル情報ファイルのみではD-Caseエディタでグラフィカルに操作することができない。D-Caseエディタで

利用するには対応する GMF ダイアグラムファイルが必要である。 

GMF モデル情報ファイルを D-Case エディタで扱うためにGMFモデル情報ファイルからGMFダイアグラムファイ

ルを生成する機能を提供している。 

 

GMF モデル情報ファイルから GMF ダイアグラムファイル生成操作フロー 

No .  操作  アクション 詳細 

1 project Explore の File 一覧表示 View

から、GMF ダイアグラムファイルを生成

したい GMF モデル情報ファイルを選択

する。 

選択したファイルの表示が反転し

て選択中状態になる。 

ファイルが選択状態となる。 

2 コンテキストメニューから Initialize 

D-Case Diagram diagram file を

選択する。 

ウイザード画面が表示される。 ウイザードによる情報の設定を

行なう。 

3 GMF ダイアグラムファイルを作成したい

フォルダを選択する。 
フォルダが選択され、Filename に

デフォルトの GMF ダイアグラムファ

イル名称が設定される。 

ウイザードによる情報の設定を

行なう。 

4 Finish ボタンを押下する。 生成処理が実行され、GMF ダイア

グラムファイルが作成される。 

GMF ダイアグラムファイルを生

成する。 

表 38 GMF モデル情報ファイルから GMF ダイアグラムファイル生成操作フロー 
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5 . 3 .  ダイアグラム印刷  

「File」メニュー内の以下の項目を選択することにより印刷に関する操作ができる。 

1. 「Print Preview」項目 印刷プレビュー 

2. 「Print...」項目 印刷 

3. 「Page Setup...」項目 印刷用紙設定 

 

5 . 4 .  EPS ファイル出力  
編集中のダイアグラムを ESP ファイルとして出力する。 

キャンバスあるいはノード、リンクを選択し、コンテキストメニューから”File”>”Save As EPS File…”を選択

する。 

 

EPS ファイルへの変換は、バッチファイルから GhostScript を呼び出す。 

変換は以下に配置したバッチファイルにより行う。 

 

バッチファイルの配置場所を以下に示す。 

ワークスペース配下の以下の場所  

 

dcase/convertPdfToEps.bat 
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6 .  Append i x  
 

6 . 1 .  メニューのアクセスキー  

キーボード操作による各メニューの呼び出しを可能とする。下表に示すメニューの、下線で表示された文

字をアクセスキーとして割り当てる。 

 

メニューバー  

D-Case 

Convert File Type 

From GMF To D-Case Model 

From D-Case To GMF Model 

From GMF To ARM 

XSL Transform From GMF Model 

Find/Replace  

File 

Copy To... 

Rename... 

Compare To... 

Switch Source and Target 

表 39 メニューバー 

 

Argument およびノードのコンテキストメニュー  

Parameters 

Configure Parameters... 
*Argumentを除く  

Set Parameters... 
*Argumentを除く  

Configure Global Parameters... 
*Argumentのみ  

Set Global Parameters... 
*Argumentのみ  

Set Requirements...   

Arrange 

Vertical 

*Argument のみ  

Horizontal 

*Argument のみ  

Select subtree 

*Argument を除く   

Add Child Create a New Node 

Goal 

Strategy 

Evidence 

Monitor 

Assumption 

Undeveloped 

Module 

Contract 

Context 

Justification 

System 

Policy 

Userdef001 
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Userdef002 

Userdef003 

Add a Template Complement.xml の定義による 

  

Convert Node Type 

Goal  

Strategy  

Evidence  

Monitor  

Assumption  

Undeveloped  

Module  

Contract  

Context  

Justification  

System  

Policy  

Userdef001  

Userdef002  

Userdef003  

Calculate the Score   

Attachment 

Select from Workspace  

Select from Web...  

Open  

Node Link 
Select from Workspace...  

Open with D-Case Editor  

Risk Analysis Open with Web Browser  

Show / Hide Children 
Show Children  

Hide Children  

DS-Bench 

Select Test Scenario 

※Strategy ノードのみ 
 

Set Parameters... 

※Goal ノードのみ 
 

Execute 

※Goal ノードのみ 
 

Refresh 

※Goal ノードのみ 
 

Set Sibling Order   

File Save As Eps File...  

表 40 Argument およびノードのコンテキストメニュー 

 

モデル情報ファイルのコンテキストメニュー  

Initialize dcase_diagram 

diagram file   

表 41 モデル情報ファイルのコンテキストメニュー 
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7. 注意制限事項  
7 . 1 .  ダイアグラムファイルのコピーについて  

ダイアグラムファイルは 2 ファイルから構成されています。ファイルのコピーを行う際には、ドラッグ&ドロッ
プやコピー&ペーストではなく、「2.5 ダイアグラムのコピー」の機能を使用してコピーを行ってください。 
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